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Lập trình đồ họa dành cho
đo lường, điều khi ển và
kiểm tra. 

• Phát triển ứng dụng một cách
nhanh chóng với những VI thân
thiện và sử dụng môi trường đồ
hoạ đơn giản

• Thiết kệ đo lường và điều khiển
với giao diện DAQ cho quá trình
kết nối với tất cả các kiểu dữ liệu
vào/ra. 

• Mở rộng với các ứng dụng thời
gian thực (Real-Time) cho FPGA 
và PDA.

• Tài liệu hướng dẫn, trợ giúp với
nhiều ngôn ngữ khác nhau.

• Tài liệu TV EVTAtech đang viết.
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• Cuốn sách có tên “Electronic Design” - một phát minh lớn
của LabVIEW đã đứng vị trí Top 50 mốc quan tr ọng của
ngành công nghi ệp điện.

• LabVIEW 6.1 đã nhận được nhiều giải thưởng tự động
hoá xu ất sắc vào n ăm 2002.

• Giải thưởng thiết kế mới với bộ LabVIEW 6i – một công
cụ mang l ại hi ệu suất cao nh ất cho ngành công nghi ệp
điện năm 2000

• LabVIEW 6i được lựa chọn là “Best of the Best” trong
danh sách phần mềm được đánh giá bởi những người
trong ngành

LabVIEW – một ứng dụng hữu ích
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T5 - 2003

T1 - 2002

T4 - 2000

T3 - 1998

T2 - 1996

T8 - 1993

T9 - 1992

T1 - 1990

T10 - 1986

T4 - 1983   

• LabVIEW 7 Express VIs,  I/O Assistants,  FPGA/PDA t argets

• LabVIEW 6.1 Có kh ả năng ho ạt động mạng networ, phân tích

• LabVIEW 6 i Đo lường thông minh, k ết nối

• LabVIEW 5.0 ActiveX, chuyên xâu

• LabVIEW 4.0 Nhi ều công c ụ chuyên nghi ệp, gỡ rối hoàn thi ện

• LabVIEW 3.0 là phiên b ản nền tảng của LabView

• LabVIEW cho Windows

• LabVIEW 2.0 cho Macintosh

• LabVIEW 1.0 cho Macintosh

• LabVIEW project begins – b ắt đầu dự án

NI LabVIEW: L ịch sử quá trình t ăng tr ưởng
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Phần mềm nhúng vào Labview
• Wolfram Research Mathematica ®

• Microsoft Excel ®
• MathWorks MATLAB® và Simulink®

• MathSoft MathCAD ®
• Electronic Workbench MultiSim ®

• Texas Instruments Code Composer 
Studio®

• Ansoft RF circuit design software
• Microsoft Access ®
• Microsoft SQL Server ®
• Oracle ®

Sản phẩn công ngh ệ mang tính th ương mại
Các giao th ức truy ền

thông
• Ethernet
• CAN
• DeviceNet
• USB
• IEEE 1394
• RS-232
• GPIB
• RS-485
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PC, Mac, Linux, Sun

LabVIEW ứng dụng mọi nơi

Networked I/O

PC Boards

Workstation

Handheld

Embedded
(FPGA)

Industrial Computer (PXI)

Wireless

Sensor

Tektronix Open Windows 
Oscilloscopes
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Họ LabVIEW

NI LabVIEW
Phần mềm lập trình đồ họa dành cho đo lường và điều khi ển

LabVIEW Real-Time Module LabVIEW FPGA Module LabVIEW PDA Module LabVIEW Datalogging and
Supervisory Control Module
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Cái có đ��c, phân tích và h �u hi�u

LabVIEW là m ột ngôn ng ữ lập trình đồ hoạ khá m ạnh
trong các l ĩnh vực kiểm tra, đo lường, và điều khi ển. Có
thể thấy dõ trong 3 điểm nổi bật sau: cái có được, phân
tích và s ự hữu hi ệu.  LabVIEW là m ột phần mềm thân
thi ện, một công c ụ mạnh cho phân tích và h ữu dụng
trong l ập trình th ời gian th ực giới thực.
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Cái có đ��c ở LabVIEW
LabVIEW có th ể được sử dụng
dành cho nhi ều thi ết b ị:
• GPIB, Serial, Ethernet, VXI, PXI 

Instruments
• Data Acquisition (DAQ)
• PCI eXtensions for Instrumentation 

(PXI)
• Image Acquisition (IMAQ)
• Motion Control
• Real-Time (RT) PXI
• PLC (through OPC Server)
• PDA
• Modular Instruments

LabVIEW được kết
hợp chặt ch ẽ với
phần cứng, thêm
vào hàng ngàn k ết
nối với các thi ết b ị
vào/ra v ới hàng
trăm thi ết b ị khác
nhau.
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Phân tích ở LabVIEW
LabVIEW bao g ồm nhi ều các công c ụ
trợ giúp ng ười dùng để phân tích d ữ
liệu:
• Hơn 400 mẫu hàm phân tích đo lường

trong các biểu thức khác, tối ưu, lọc, 
toán học, chuỗi số học, thống kê, v.v...

• 12 VI Express mới đặc biệt được thiết
kế dành cho phân tích đo lường, bao
gồm bộ lọc và phân tích quan phổ.

• Các VI xử lý tín hiệu dành cho Filtering, 
Windowing, Transforms, Peak 
Detection, Harmonic Analysis, 
Spectrum Analysis, v.v.

Hệ thống phân tích
đo lường mạnh
được xây d ựng trên
môi tr ường phát
tri ển Labview.  
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S� h�u hi�u ở LabVIEW
LabVIEW includes the following 
tools to help you present your 
data:
• On your machine — Graphs, Charts, 

Tables, Gauges, Meters, Tanks, 3D 
Controls, Picture Control, 3D Graphs 
(Windows Only), Report Generation 
(Windows Only)

• Over the Internet — Web Publishing 
Tools, Datasocket (Windows Only), 
TCP/IP, VI Server, Remote Panels, 
Email

• Enterprise Connectivity Toolset —
SQL Tools (Databases), Internet 
Tools (FTP, Telnet, HTML)

LabVIEW có th ể làm
việc trên PC c ủa bạn
hoặc ngay c ả trên m ạng
network, ho ặc bạn có
thể thêm vào nh ững
ứng dụng là 1 l ợi thế
giống nh ư DIAdem.



12

Các bài s ẽ giới thi ệu về Labview cu ốn này

Giới thi ệu
LabVIEW

Vòng l ặp

Lập trình
Modular 

Tuỳ biến
VI

Thu th ập dữ liệu
và dạng sóng

Công c ụ
điều khi ển

Mảng

Plotting Data

Clusters

Decision 
Making in a VI

Chuỗi và file 
vào/ra
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Điều đạt được của khoá h ọc

• Hiểu được Front panels, biểu đồ thành lập các khối thành một hệ
thống, và các thiết bị kết nối. 

• Biết sử dụng cấu trúc các chương trình và các dạng dữ liệu mà
chúng tồn tại ở LabVIEW

• Biết sử dụng linh hoạt cách sắp xếp dữ liệu cho việc lập trình máy
tính và kỹ thuật xác định, sửa các lỗi trong một chương trình.

• Tạo ra và lưu trữ các VI của bạn vì vậy bạn có thể dùng chúng như
những VI phụ trợ.

• Hiển thị và lưu trữ dữ liệu của bạn.

• Tạo ra những ứng dụng sử dụng những bảng plug-in data 
acquisition (DAQ)

• Tạo ra các ứng dụng mà sử dụng GPIB và chuỗi các thiết bị cổng.

Khoá h ọc này chu ẩn b ị cho b ạn:
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Khoá h ọc có th ể mang l ại.

• Xây dựng VI trong LabVIEW, chức năng, 
hoặc thư viện VI

• Thuyết tương tự và công nghệ.
• Hoạt động chi tiết của chuỗi cổng hoặc bus 

GPIB

• Làm thế nào để phát triển một công cụ điều
khiển.

Mục đích của khoá h ọc đó không ph ải là để bàn
luận về những v ấn đề như là:
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Bài học 1: 
Giới thi ệu về LabVIEW

Chủ đề nghiên c ứu
•Môi trường LabVIEW

•Giao diện Labview
•Biểu đồ thiết lập các khối thành một hệ thống

•Lập trình
•Trợ giúp trong LabVIEW

•Gỡ rối 1 VI
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Virtual Instruments (VIs)
– Những công c ụ ảo

Giao diện chính
• Controls = Inputs (Vào)
• Indicators = Outputs (Ra)

Biểu đồ khối
• Các khối chương trình

của giao diện chính
• Các thành phần đi dây.
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Hộp tho ại khởi động LabVIEV
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Tạo một VI mới
• File»New VI để tạo 1 VI mới

• File»New… Để mở một hộp thoại mới và cấu hình cho
một VI, đặt các biến số, điều khiển, v.v…
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Mở các m ẫu có s ẵn
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Menu

File   Edit   O perate   T ools   B rowse   W indow   H elp

Di chuyển và click đến thực đơn trên Menu 
để lựa chọn theo các yêu cầu của bạn
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Giao di ện phía tr ước

Thanh công
cụ

Chú thích
đồ thị

Nút điều
khiển

Đồ thị
dạng sóng

Biểu tượng

Chú thích
Plot

Chú thích
Scale

Nhãn đồ
thị sóng
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Đồ th ị khối

Đi dây

Đồ thị

Một
SubVI

Cấu trúc vòng
lặp While

Các công
Cụ Hàm chia

Hằng số Hàm thời gian
(Kiểu delay)

Nút điều khiển dạng
Boolean
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Các thanh công c ụ và biểu đồ khối

Chạy ứng dụng

Chạy ứng dụng liên t ục

Ngừng ch ạy

Tạm dừng/Ti ếp tục

• Hiển th ị quá trình thi hành

• Nút Step Into

• Nút Step Over

• Nút Step Out

Chỉ dẫn

Chấp nhận

Chạy đứt quãng

Font ring

Alignment ring

Distribution ring

Resize ring

Reorder ring

Trợ giúp ng ữ cảnhNhững nút được thêm vào
trên thanh công c ụ
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Bảng công c ụ

• LabVIEW tự động chọn những công cụ cần thiết.

• Hiển thị trên Front panel và trên biểu đồ thiết lập
hệ thống.

• Các chức năng công cụ có thể lựa chọn ở chế độ
đặc biệt theo con trỏ chuột.

• Sử dụng các công cụ để tạo và chỉnh sửa giao
dịên chính và các đối tượng của biểu đồ khối

• Hiển thị bảng công cụ (Tools Palette), chọn
Window»Show Tools Palette
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Giao di ện chính - B ảng điều khi ển
(Controls Palette)

Controls Palette
Bao gồm hầu hết các hàm phổ biết nhất được

sử dụng để điều khiển

Bảng Controls
Hiển thị các chức năng điều khiển
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Biểu đồ khối− Bảng các hàm
(Functions Palette)

Functions Palette
Bao gồm các VI (Các VI tương tác với trang
cấu hình) và hầu hết các thành phần phổ biến
của các hàm.

Bảng Functions 
Hiển thị tất cả các hàm
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Bảng các công c ụ

• Là các bảng dạng đồ hoạ, luân chuyển
• Bảng cấp 2 được luân chuyển từ bảng

chính
• Sử dụng bảng lựa chọn để thay đổi tổng

quan từ lựa chọn nhanh sang chuyên
nghiệp

Tìm kiếm Lựa chọn

Nhấp chuột vào thành phần VI cần dùng để dưa tới bảng các VI tiếp theo

Lên bản trên
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Tìm ki ếm một Controls, VIs, và Functions

• Nhấp vào nút search và
gõ chữ bạn muốn tìm.

• Nhấp chuột và kéo thả
mội thành phần từ cửa sổ
tìm kiếm tới biểu đồ khối
hoặc nhấp đúp chuột vào
thành phần đó để mở
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Bảng Control & Function theo ng ười dùng

• Các thư viện vi.lib bên trong thư mục của LabVIEW
• Thay thế các thành phần bên trong user.lib hoặc instr.lib để

các Vi được đưa vào bảng Controls và Functions

Vào: Programs» National Instruments»LabVIEW
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Xây dựng một dự án với nút điều khiển controls (đưa vào) 

và chỉ thị indicators (đầu ra)

Giá trị
điều khiển

Giá trị
chỉ thị

Nhãn

Nút tăng
giảm

Điều khiển
Boolean

Chỉ thị
Boolean

Tạo một giao di ện VI nho nh ỏ
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Các Menu t ắt cho đối tượng Front Panel

Click chuột phải vào
nhãn để hiển thị menu 
tắt

Click chuột phải vào khung
hiển thị số để truy xuất menu 
tắt
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Trang đặc tính

Click chuột phải lên
một trình điều
khiển hoặc chỉ thị
trên Front panel và
lựa chọn Properties 
từ menu tắt để xác
lập hộp thoại đặc
tính cho đối tượng.
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Các hàm toán họcĐi dây

Giá trị
điều khiển

Block DiagramFront Panel
Giá trị
chỉ thị

Tạo một VI Block Diagram
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Express VIs, VIs và Functions
• Express VIs: Các VI chuyên nghiệptương tác với trang hộp thoại

cấu hình
• Standard VIs: Các VI tiêu chuẩn được tuỳ biến đi dây
• Functions: Những thành phần hoạt động chủ yếu của LabVIEW

(không phải Front panel hoặc Block diagram)
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Các điểm nút trong Block Diagram
Icon                                   Nút mở rộng Nút mở rộng

• Hàm VI cơ bản
• VI có 3 đường ra khác nhau
• Trường màu vàng chỉ định một VI tiêu

chuẩn
• Trường màu xang chỉ địng cho một VI 

Express
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Block Diagram Terminals

• Terminals là cổng ra và cổng
vào để trao đổi thông tin giữa
panel và diagram 

• Terminals tương tự như tham
số và hằng số trong ngôn ngữ
lập trình cơ bản.

• Click chuột phải và chọn View 
As Icon để thay đổi tổng quan
icon
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Các dạng dây n ối trên Block Diagram 

Vô hướng

Kiểu Numeric

Kiểu Boolean

Kiểu String

Mảng 2 chi ềuMảng 1 chi ều

Kiểu Dynamic
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Kỹ thuật đi dây
Hot Spot

• Tự động đi dây
• Sử dụng cửa sổ trợ giúp Context Help Window

khi đi dây
• Click chuột phải lên dây và chọn Clean Up Wire (Ctrl+B)
• Chú ý các dải Tip
• Tự động lộ trình đi dây
• Click chuột phải lên Terminals

và lựa chọn Visible 
Items»Terminals

View the terminal connections to a function
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• Block diagram thực thi phụ
thuộc vào luồng dữ liệu thì
Block diagram sẽ KHÔNG 
thực thi từ trái qua phải

• Node sẽ thực hiện khi dữ
liệu sẵn sàng đưa tới tất cả
đầu vào của terminals.

• Node cung cấu dữ liệu cho
tất cả đầu ra của terminals 
khi làm việc.

Lập trình lu ồng dữ liệu
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Trợ giúp ng ữ cảnh
• Để hiển thị cửa sổ trợ giúp ngữ cảnh ta lựa chọn

Help»Show Context Help , hoặc ấn tổ hợp phím <Ctrl-H>, 
hoặc nhấp nút Show Context Help Window trên thanh
công cụ

• Di chuyển con trỏ tới đối
tượng để hiển thị trợ giúp

• Kết nối:
Cần thi ết– chữ béo
Đề nghị– chữ thường
Tuỳ ý- chữ mờ

Trợ giúp ngữ cảnh thông thường Khoá trợ giúp Trợ giúp chi tiết
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Trợ giúp trong LabView

• Click vào trợ giúp chi tiết trên cửa sổ trợ giúp ngữ cảnh
• Lựa chọn Help»VI, Function, & How-To Help
• Click vào Click here for more help trong cửa sổ trợ giúp

ngữ cảnh.

Tại đó mô tả chi tiết hầu hết các palettes, menus, tools, VIs, 
và functions, hướng dẫn từng bước các lệnh được sử dụng
trong LabVIEW, các tính năng, các liên kết tới hướng dẫn, 
các văn bản PDF là sách hướng dẫn LabVIEW, những chú
ý, và tài nguyên hỗ trợ về công nghệ.
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Tìm ki ếm những ví d ụ

• Để tìm kiếm những ví dụ
có sẵn trong LabVIEW, ta
lựa chọn Help»Find
Examples

• Web-tích hợp
• Tìm theo từ khoá, kiểu ví

dụ, kiểu phần cứng, v.v.
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Kỹ thuật gỡ rối

Tìm lỗi
Nhấp nút có biểu tượng bên. Một cửa sổ sẽ
xuất hiện hiển thị các bảng lỗi.

Execution Highlighting
Click vào nút Execution Highlighting; Những giá
trị hiển thị trên các dây nối.



44

Kỹ thuật gỡ rối
Probe – th ăm dò

Click chuột phải lên dây và lựa chọn probe, nó
sẽ hiển thị dữ liệu của các đoạn nối dây

Breakpoints – điểm gãy
Click chuột phải và lựa chọn Set Breakpoint; 
quá trình thi hành sẽ dừng lại ở điểm gãy.

Conditional Probe – Th ăm dò điều kiện
Đó là sự kết hợi giữa điểm gãy (breakpoint) và
thăm dò (probe).  Nhấp chuột phải lên dây và
chọn custom probe .
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Kỹ thuật gỡ rối

Những nút Step Into, Over, and Out để thực
hiện gỡ rối từng bước đơn một.

Click vào nút Step Into cho phép thực hiện từng
bước đơn.

Click vào nút Step Over cho phép thực hiện
từng bước đơn hoặc những điểm step over.

Click vào nút Step Out cho phép thực hiện từng
điểm
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Tóm tắt
• Virtual instruments (VIs) có 3 phần chính - Front panel, Block diagram, 

biểu tượng và ô nối

• Front panel là giao diện người dùng của ngôn ngữ LabVIEW và Block 
diagram là mã thực thi.

• Block diagram bao gồm mã nguồn đồ hoạ của các nút, đầu cuối, và
các đường đi dây

• Sử dụng Express VIs, những VIs chuẩn và các hàm ở trong Block 
diagram để tạo mã cho riêng bạn.  Phần lớn nhu cầu chung đều sử
dụng Express VIs sẵn có các hộp thoại cấu hình tương tác tạo ứng
dụng cho riêng mình.

• Floating Palettes: Bảng công cụ, bảng điều khiển (chỉ có khi cửa sổ
Front Panel đã active), và bảng hàm (chỉ có khi cửa sổ Block Diagram 
đã active)

• Tiện ích trợ giúp bao gồm cửa sổ trợ giúp ngữ cảnh và trợ giúp trong
LabVIEW.
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Tóm tắt
• Đối tượng điều khiển (đầu vào) và đối tượng chỉ thị (đầu ra) ở trong cửa sổ Front 

panel.

• Sử dụng Operating tool để vận dụng các đối tượng Panel. Sử dụng Positioning 
tool để lựa chọn, di chuyển, và định lại cỡ của đối tượng panel. Sử dụng Wiring 
tool để kết nối các đối tượng trong đồ thị.

• Các đối tượng điều khiển đầu cuối cho đường viền dày hơn đối tượng chỉ thị đầu
cuối.

• Tất cả các đối tượng Front panel objects đều có trang thuộc tính và các menu tắt.

• Đi dây là một kỹ thuật cho điều khiển luồng dữ liệu và đưa ra kết quả trong ngôn
ngữ LabVIEW.

• Khi mà nút mũi tên Run có biểu tượng bị gãy điều đó có nghĩa là ứng dụng VI 
không thể thực thi

• Những tùy chọn và công cụ gỡ rối khác nhau cho giá trị thiết lập như nhau: thăm
dò (probe) và điểm gãy (breakpoint), đèn báo thực thi, và các bước gỡ rối đơn.
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Mẹo vặt
• Các phím tắt

• Gọi bảng công cụ băng cách giữ <shift>-click chuột phải

• Tăng/Giảm nhanh sử dụng khóa <shift>

• Chọn Tools»Options — để thiết lập tính ưu tiên trong
LabVIEW

• File»VI Properties – thuộc tính VI

Windows      Sun        Linux       MacOS
<Ctrl-R> <¨-R> <M-R> <z-R> Chạy file VI
<Ctrl-F> <¨-F> <M-F> <z-F> Tìm đối tượng
<Ctrl-H> <¨-H> <M-H> <z-H> Mở cửa sổ trợ giúp ngữ cảnh
<Ctrl-B> <¨-B> <M-B> <z-B> Loại bỏ các đường đi dây lỗi
<Ctrl-W> <¨-W> <M-W> <z-W> Đóng cửa sổ làm việc
<Ctrl-E> <¨-E> <M-E> <z-E> Chuyển đổi cửa sổ Giao diện/Mã
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Bài học 2
Lập trình theo Modul

Các chủ đề liên quan
SubVIs

Icon và Connector Pane
Sử dụng SubVIs

Tạo một SubVI từ các phần trong một VI
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Thứ bậc trong LabVIEW

SubVI
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SubVIs

Function Pseudo Code
function average (in1, in2, out)
{
out = (in1 + in2)/2.0;
}

SubVI Block Diagram

Calling Program Pseudo Code
main
{
average (point1, point2, pointavg)
}

Calling VI Block Diagram
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Icon/Connector

Một icon miêu tả gợi nhớ cho VI đó
trong mỗi block diagram khác nhau

Một connector đưa dữ liệu tới và nhận
dữ liệu từ một subVI thông qua vùng
đưa ra

Icon

Connector

Terminals

Terminals
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Ví dụ một SubVI – m ột phép tính c ơ bản

• Một VI nằm trong một VI khác được gọi là subVI
• Để sử dụng một VI giống như một subVI, ta tạo một icon và

connector pane sau đó xây dựng Front panel và Block 
diagram
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Tạo Icon
• Icon: biểu tượng miêu tả gợi nhớ của 1 VI
• Click chuột phải lên icon pane (Panel hoặc

Diagram) ở góc cửa sổ
• Nên tạo một icon đen trắng

Icon mặc định Tạo một icon theo người làm
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Tạo Connector

Click chuột phải lên icon 
(Chỉ trong Front Panel)
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Tạo Connector – ti ếp...
Chọn điểm
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Tạo Connector – ti ếp...
Đầu ra có màu khớp với kiểu dữ liệu mà chúng liên kết tới.

Click vào đầu ra để nhìn thấy đối tượng Front panel kết
hợp
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Sử dụng một VI giống nh ư
SubVI
All Functions » Select a VI…

<Hoặc>
Kéo thả icon tới Block diagram đích



59

Trợ giúp và phân lo ại đầu cuối

Phân loại đầu vào/ra:
• Required — Lỗi nếu không kết nối
• Recommended — Cảnh báo nếu không kết nối
• Optional — Không có tác dụng nếu không kết

nối
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Tạo SubVI tùy ch ọn
• Khoanh vùng muốn tạo một subVI

• Chọn Edit » Create S ubVI để thấy kết quả
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Tóm tắt
• Các VI có thể được sử dụng giống như những subVI

sau khi bạn đã tạo icon và connector
• Để tạo Icon sử dụng Icon Editor
• Connector được định bởi số lựa chọn của đầu cuối
• Nạp vào subVI sử dụng tùy chọn Select a VI ở trong

bảng All Functions hoặc kéo thả icon vào một diagram 
mới.

• Trợ giúp trực tuyến cho subVI sử dụng lựa chọn Show 
Context Help

• Mô tả chức năng đối tượng
• Sử dụng tính năng Create SubVI để dễ dang tạo những

Modul của Block diagram



62

Bài học 3
Lặp lại và các vòng l ặp

CÁC CHỦ ĐỀ
Vòng lặp While
Vòng lặp For
Truy xuất dữ liệu vòng lặp trước đó
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Vòng l ặp While

Vòng lặp While trong LabVIEW Lưu đồ thuật toán Sinh mã

Repeat (code);

Until Condition met;

End;
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Vòng l ặp While
1. Chọn While Loop 2. Khoanh vùng mã muốn đặt trong vòng lặp

3. Kéo thả vào vòng lặp các nút và sau đó đi dây
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Lựa chọn vòng l ặp điều kiện

Mặc đinh: Stop nếu là True

Lạp lại ở đầu ra Điều kiện đầu ra
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Cấu trúc Tunnel
• Các Tunnel cho dữ liệu đi vào và đi ra khỏi cấu trúc. 

• Tunnel là một khối được xuất hiện trên khung; màu của
khối có liên quan tới kiểu dữ liệu được nối tới tunnel. 

• Khi mà một tunnel đưa dữ liệu vào vòng lặp, 
thì vòng lặp chỉ thực hiện
sau khi dữ liệu đến.

• Dữ liệu đi ra ngoài của vòng
lặp sau khi kết thúc vòng lặp. 
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Vòng l ặp For

Vòng lặp For trong LabVIEW Lưu đồ thuật toán Sinh mã

N=100;

i=0;

Until i=N:

Repeat (code; i=i+1);

End;
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Vòng l ặp For
• Nằm trong Structures của Functions
• Mã được tạo trong vòng lặp
• Quá trình lặp phụ thuộc vào thời gian

Count terminal
(Số đầu vào)

Hàm trễ (ms)
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Hàm trễ
Wait Until Next 
ms Multiple

Functions»Time
& Dialog
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Hàm trễ
Wait (ms)

Functions»Time
& Dialog palette

Time Delay

Functions»Time
& Dialog palette
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Chuyển đổi số
• Các số mặc định thường double (8 bytes) hoặc long 

integer 
(4 bytes)

• LabVIEW chuyển đổi tự động các giá trị tương đương
• Vòng lặp For tính đầu cuối luôn luôn chuyển thành dạng

long integer
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Chuyển đổi số
• LabVIEW lựa chọn tình trạng cụ thể để sử dụng lượng

bit. 
• Nếu như lượng bit là tương đương thì

LabVIEW sẽ lựa chọn phần không đánh
dấu thay vì phần đánh dấu.

• Để lựa chọn phần thể hiện, 
click chuột phải lên đối tượng cuối
và lựa chọn mục Representation .

• Khi mà LabVIEW chuyển đổi những điểm thay đổi từ
numeric thành integer, nó sẽ làm chẵn về kiểu integer 
gần nhất. LabVIEW làm chẵn tới x.5 dạng integer gần
nhất. 
Ví dụ như, LabVIEW đưa 2.5 thành 2 và 3.5 thành 4.
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Truy xu ất dữ liệu vòng l ặp trước đó – Thanh d ịch chuy ển

• Nó có giá trị ở bên phải hoặc trái của khung cấu trúc vòng lặp
• Click chuột phải vào khung và chọn Add Shift Register 
• Đầu ra bên phải sẽ lưu trữ dữ liệu trong sự hoàn thành của

phép lặp.
• Đầu ra bên trái sẽ cung cấp dữ liệu đã được lưu trữ ở dạng

ban đầu của bước lặp kế tiếp

Trước
vòng lặp
bắt đầu

Vòng lặp I Vòng lặp II Vòng lặp
cuối

Initial Value

Value 1

Value 1

Value 2

Value 2

Value 3

Giá tr ị 3
Giá tr ị
ban 
đầu
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Thêm vào thành ph ần của Shift Register

Latest value
is passed to
right terminal

Click chuột
phải lên vòng
lặp ở bên trái
khung để tham
vào đối tượng

Previous values are available at 
the left terminals

Click chuột phải
lên phía bên
phải khung để
thêm vào một
shift register

1 loop ago

2 loops ago

3 loops ago
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Nút ph ản hổi

•Sẽ xuất hiện tự động trong vòng lặp For hoặc
While nếu như bạn đi dây ở đầu ra của một
subVI, function, hoặc group của subVI và
functions tới đầu vào của VI tương đương, 
function, hoặc group. 

•Dữ liệu lưu trữ khi mà hoàn tất một vòng lặp, 
gửi dữ liệu tới vòng lặp kế tiếp và truyền đi
mọi kiểu dữ liệu.
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Nút ph ản hồi

• Đi dây từ đầu ra tới đầu
vào được tự động tạo ra
một nút phản hồi
<Hoặc>

• Đặt một nút phản hồi từ
bảng
Functions»Structures
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Khởi ch ạy Shift Registers & nút ph ản hồi

Một lần chạy Dừng VI Chạy lại

Đầu ra = 5Đầu ra = 5

Đầu ra = 5 Đầu ra = 5
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Không ch ạy Shift Registers & Nút ph ản hồi

Một lần chạy Dừng VI Chạy lại

Đầu ra = 8Đầu ra = 4

Đầu ra = 4 Đầu ra = 8
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Tóm tắt

• Có 2 cấu trúc vòng lặp chính: Vòng lặp While và vòng lặp
For.

• Tạo trễ hay thời gian cho vòng lặp sử dùng hàm Wait Until 
Next ms Multiple , hàm Wait (ms) , hoặc Time Delay 
Express VI .

• Đầu vào vòng lặp là một dạng số học nào thì đầu ra sẽ là
một dạng số học đó.

• Feedback nodes và shift registers sẽ truyền giá trị dữ liệu
từ một vòng lặp trước tới vòng lặp kế tiếp

• Chỉ sử dụng shift registers khi mà có nhiều phép lặp cần
được sử dụng.
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Bài học 4
Mảng - Arrays

CÁC CHỦ ĐỀ

Giới thiệu về mảng - Arrays

Tự động chỉ thị mảng

Array Functions

Nhiều mảng kết hợp
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• Tập hợp các thành phần dữ liệu là các dạng tương đương

• Một hoặc nhiều chiều, nhiều hơn 2 thành phần cho mỗi chiều
• Truy xuất các thành phần bởi chỉ mục của chúng; thành phần ban 
đầu có giá trị chỉ mục là 0

31

Chỉ mục
10 mảng thành phần

1.2 3.2 8.2 8.0 4.8 5.1 6.0 1.0 2.5 1.7
0     1     2     3     4     5     6     7     8     9

Mảng 2 chiều (2D)

Mảng có 5 dòng, 7 cột có 35 thành phần

0    1    2     3    4     5    6
0 
1 
2 
3
4

Mảng - Arrays
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Add Dimension
cho mảng 2D

1. Chọn Array từ bảng Controls 2. Đặt đối tượng dữ liệu bên trong shell

Mảng Điều khi ển và ch ỉ th ị
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1. Chọn Array 
Constant từ bảng
con của mảng
Array

2. Đặt đối tượng dữ liệu vào trong cột
mảng đó

Tạo mảng hằng số
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• Vòng lặp có thể gồm
nhiều mảng tự động chỉ
thị với đường biên của
chúng

• Vòng lặp For tự động chỉ
thị mặc định

• Vòng lặp While đưa ra có
giá trị kết thúc mặc định.

• Click chuột phải lên
tunnel (ô màu vàng nhỏ
trên khung) và
enable/disable auto-
indexing

Tự động ch ỉ th ị - Auto-Index

Đường dây trở thành đậm hơn

Đường dây mảnh hơn

Không cho phép Auto-
Indexing

Cho phép Auto-Indexing

Chỉ có 1 giá trị (ở vòng lặp
cuố) tại vòng lặp ở đầu ra

1D Array
0    1     2     3    4     5
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• Vòng lặp bên trong được tạo ra là các cột
• Các ngăn xếp của vòng lặp ngoài sẽ được dây vào dòng

Tạo mảng 2 chi ều - 2D Arrays

1D Array

0    1     2     3    4     5

2D Array
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Đầu vào Auto-Index

• Một mảng đầu
vào có thể được
sử dụng để thiết
lập vòng lặp For 

• Số thành phần
trong mảng
tương đương
với bộ đếm đầu
vào

• Mũi tên nút Run 
khôngbị gãy.
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Cỡ của mảng

Mảng kh ởi ch ạy

Các hàm m ảng ph ổ biến
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Tập hợp mảng

Các hàm m ảng ph ổ biến
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Xây dựng hàm m ảng

Xây dựng một mảng nhi ều chi ều hơn

Đầu vào n ối ti ếp nhau

Đưa thêm thành ph ần dữ liệu

M�c đ�nh
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Hàm Index Array

Trích 1 thành ph ần

Trích thành ph ần của dòng

Trích 1 dòng
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Những hàm đầu vào có thể có kiểu khác nhau
Các hàm số học của tất cả phiên bản LabVIEW đều có nhiều dạng khác

Vô hướng + Vô hướng

Mảng + vô hướng

Kết hợp Kết quả

Vô hướng

Mảng

Mảng

Mảng + mảng

Mảng + mảng

Mảng

Các dạng khác
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• Nhưng thành phần dữ liệu trong nhóm mảng đầu có kiểu tương
đương. Bạn có thể xây dựng nhiều mảng: numeric, Boolean, path, 
string, waveform, và kiểu dữ liệu cluster. 

• Mảng chỉ thị cơ sở là 0, có nghĩa là nó có dải từ 0 tới n – 1, trong
đó n là một số trong mảng. 

• Để tạo 1 mảng điều khiển hoặc chỉ thị, ta lựa chọn một mảng ở
bảng sau: Controls»Array & Cluster , thay thế nó trong Front 
panel, và kéo thả đối tượng điều khiển hoặc chỉ thị vào cấu trúc
mảng.

• Nếu bạn đi dây một mảng đầu vào cho vòng lặp For hoặc While, 
bạn có thể đọc và quy trình cho các thành phần trong mảng bằng
cách enable auto-indexing.

• Mặc định ban đầu, LabVIEW là enable auto-indexing trong vòng lặp
For và disable auto-indexing trong vòng lặp While.

• Các dạng khác tuỳ thuộc vào dữ liệu đầu vào của cấu trúc dữ liệu.

Tóm tắt


